
Installation Instructions for Hot Fix F90008  

Windows for x64  

F90008 is a "container" hot fix that contains the following "member" hot fixes which will update 

the software components as indicated. See the Container Hot Fixes section in the Maintenance 

Install Tool (MIT) Usage Guide for more information about container hot fixes. 

G55006 for SAS Detail Data Store for Insurance 5.4_M1 

F88008 for SAS Firmwide Risk Management for Insurance Server 2.1_M1 

F89008 for SAS Market Risk Management for Insurance Server 2.1_M1 

F03003 for SAS Risk Dimensions Server Component 5.3_M1 

G61006 for SAS Risk Management for Insurance Mid-Tier 2.1_M1 

F12009 for SAS Risk Management for Insurance Server 2.1_M1 

G54006 for SAS Risk Reporting Repository 1.4_M1 

F92008 for SAS Underwriting Risk Management for Life Insurance Server 2.1_M1 

F91008 for SAS Underwriting Risk Management for P&C Insurance Server 2.1_M1 

 

Before applying this hot fix, follow the instructions in SAS Note 35968 to generate a SAS 

Deployment Registry report, and then verify that the appropriate product releases are installed on 

your system. The software components and release numbers should match the list of software 

components updated by the individual hot fix installers.  

IMPORTANT NOTES 

1.      Files delivered in this hot fix will be backed up during the installation process. However, 

it is good general practice to back up your system before applying updates to software. 

2. When applying this hot fix, the -alwaysoverwrite option should be used. This option 

causes the hot fix to overwrite files that are currently on your system with the updated hot 

fix version of those files. ANY customizations that may have been made to files included 

in the hot fix will be lost. The hot fix installer will automatically back up files for you. 

After the hot fix has been installed, use the backup copies to merge any of the 

customizations that you wish to retain. Links to manifests are provided in the section 

above to assist in determining which files will be overwritten. 

3. Take backups of all .spk files prior to importing newer versions or making any updates to 

the contents of an existing .spk file. This can be done by first logging into the SAS 

Management Console (SMC) using the Administrator (sasadm) user, navigating to the 

appropriate folder containing metadata and exporting the folder contents to a uniquely 

named .spk file.  

4. Configurations and related uncompiled macro files for the following reports will be 

updated as a part of this install:  

ASSETS-D1 

ASSETS-D1Q 

http://ftp.sas.com/techsup/download/hotfix/HF2/Maint_Install_Tool.pdf
http://ftp.sas.com/techsup/download/hotfix/HF2/Maint_Install_Tool.pdf
http://support.sas.com/kb/35/968.html


ASSETS-D1S 

ASSETS-D2O 

ASSETS-D2T 

ASSETS-D3 

ASSETS-D4 

ASSETS-D5 

ASSETS-D6 

BS-C1 

BS-C1D 

DurLiab 

COUNTRY-K1 

COVER-A1A 

COVER-A1Q 

G01 

G03 

G04 

IGT1 

IGT2 

IGT3 

IGT4 

Lapses 

MCR-B4A 

MCR-B4B 

OF-B1Q 

P&L 

RC 

RE-J1 

RE-J2 

RE-J3 

RE-SPV 

SCR-B2A 

SCR-B2A_B2C 

SCR-B2B 

SCR-B2C 

SCR-B3A 

SCR-B3B 

SCR-B3C 

SCR-B3D 

SCR-B3E 

SCR-B3G 

TP-E1 

TP-E1Q 

TP-E2 

TP-E3 

TP-E4 

TP-E6 

TP-E7A 

TP-E7B 

TP-F1 

TP-F1Q 

TP-F2 



TP-F3A 

TP-F3B  

TP-F4 

VA-C2A 

VA-C2B 

VA-C2C  

 

The following reports from the above list have been migrated to the CP 11 Final QRT 

templates by EIOPA: 

 
Assets-D1 

Assets-D1Q 

Assets-D1S 

Assets-D2O 

Assets-D2T 

Assets-D3 

Assets-D4 

Assets-D5 

Assets-D6 

BS-C1 

BS-C1D 

DurLiab 

G01 

G03 

G04 

IGT1 

IGT2 

IGT3 

IGT4 

Lapses 

MCR-B4A 

MCR-B4B 

P&L 

RC 

SCR-B2A 

SCR-B2A_B2C 

SCR-B3A 

SCR-B3C 

SCR-B3E 

TP-E1 

TP-E1Q 

TP-F1 

TP-F1Q 

TP-F2 

TP-F3A 

TP-F3B 

TP-F4 

VA-C2B 

VA-C2C 

 



The following reports, if already existing on your system will not be available after this 

install as the reports have been dropped from the CP 11 Final QRT templates by EIOPA. 

Metadata and configurations for the reports have been removed:  

Cover-A1 

C2_ANALYSIS_LF 

C2_ANALYSIS_NL 

C2_SUMMARY 

G10 

G15 

G20 

G30 

IGT5 

IGT6 

TP-E5 

TP-E7 

VA-C2D 
 

Following reports were added / updated in the metadata per CP9 and CP 11 Final EIOPA 

QRT lists:  

Assets-D1Q 

Assets-D1S 

Assets-D2O 

Assets-D2T                                                                                   

Cover-A1A 

Cover-A1Q 

Duration liabilities 

Lapses 

Participations 

P&L Sharing 

SCR_B2A_B2C 

TP-E7A 

TP-E7B  

VA-C2A 

VA-C2B 

VA-C2C 

 

Stored Process (STP) names and descriptions have been updated in the metadata for a 

large majority of the reports to align with changes per CP 9 and CP 11 Final EIOPA 

templates. These updates can be applied to the system by importing reports.spk.  Details 

of the import process are available in the section Import updated .spk files. 

If you need to retain previous versions of these files, they can be retrieved from backup 

locations as needed.  

5. As part of this install, support for XBRL reporting has been added. In order to support 

this feature, the following tables and columns have been added to the static directory:  



Newly added tables: 

XBRL_COMPLEXTYPE 

XBRL_COMPLEXTYPE_ENUMERATION 

XBRL_DIMENSION 

XBRL_FACTELEMENTS 

XBRL_FMT 

XBRL_REPORT 

XBRL_SCHEMA  

Columns for the newly added tables: 

TABLE NAME     COLUMN NAME 

XBRL_COMPLEXTYPE    CONFIG_SET_ID 

VALID_FROM_DTTM 

VALID_TO_DTTM 

BASE_CD 

MAXINCLUSIVE 

      MAXLENGTH 

      MININCLUSIVE 

      NAME_CD 

      PATTERN_CD 

 

XBRL_COMPLEXTYPE_ENUMERATION CONFIG_SET_ID 

      VALID_FROM_DTTM 

      VALID_TO_DTTM 

NAME_CD 

      VALUE_VAR 

 

XBRL_DIMENSION    CONFIG_SET_ID 

      VALID_FROM_DTTM 

      VALID_TO_DTTM 

DIMENSION_CD 

      REPORT_CD 

DIMENSIONTYPE 

      FORMAT_CD 

      MEMBERTAG 

      VARIABLE_CD 

      VARIABLESTAG 

 

XBRL_FACTELEMENTS   CONFIG_SET_ID 

      VALID_FROM_DTTM 

      VALID_TO_DTTM 

BASETYPE_CD 

      ELEMENTCODE 

      ELEMENTNAME 

      PERIODTYPE 

      TAXONOMY 

      TYPE_CD 

 

XBRL_FMT                                 CONFIG_SET_ID                     

                 VALID_FROM_DTTM 

                 VALID_TO_DTTM                    

                 FMTNAME                           



                 START                             

                 REPORT_CD                         

                 DATATYPE                          

                 DECSEP                            

                 DEFAULT                            

                 DIG3SEP                           

                 EEXCL                             

                 END                               

                 FILL                              

                 FUZZ                               

                 HLO                               

                 LABEL                             

                LANGUAGE                          

                 LENGTH                             

                 MAX                                

                 MIN                                

                 MULT                               

                 NOEDIT                             

                 PREFIX                            

                 SEXCL                             

                 TYPE 

 

XBRL_REPORT                               CONFIG_SET_ID                     

                 VALID_FROM_DTTM                    

            VALID_TO_DTTM                      

                 DESCRIPTION                       

                 REPORT_CD                         

                 TEMPLATE_CD                       

                 ITEMVAR                           

                 VALUEVAR   

 

XBRL_SCHEMA                              CONFIG_SET_ID                     

                 VALID_FROM_DTTM                    

                 VALID_TO_DTTM                      

                 PREFIX_VAL                        

                 REPORT_CD                      

6. You must have Administrator Privileges on your CLIENT or SERVER machine.  

7. All currently active SAS sessions, daemons, spawners and servers must be terminated 

before applying this hot fix.  

8. This hot fix should be installed using the same userid that performed the initial software 

installation.  

9. On UNIX systems, you may need to adjust file permissions on all new and updated files 

to meet with your sites security guidelines.  

 

 

INSTALLATION 



This hot fix must be installed on each machine where the updated components of the product, 

listed above, are installed. The installation process will determine which components of SAS 

Risk Management for Insurance 2.1_M1 are installed on each machine, and apply the 

appropriate updates.  

If the updated components of this product are installed on multiple operating systems, you must 

download the hot fix for the appropriate operating system(s) and follow the installation 

instructions provided to complete the deployment of this hot fix.  

The installer downloaded is F90008x6.exe.  

When downloading SAS 9.2 hot fix packages, you must choose to Save the hot fix to disk, and 

then execute the install from the saved location. Attempting to install a hot fix directly from the 

download page results in the error documented in SAS Note 37104.  

 To install this hot fix execute F90008x6.exe using the -alwaysoverwrite option.  

This will initiate the installation wizard, which will guide you through the hot fix installation 

process.  

Note: If your Windows operating system is Windows Vista, Windows 7 or Windows Server 

2008, it may be necessary to "right-click" F90008x6.exe and select "Run as administrator".  

See the Maintenance Install Tool (MIT) Usage Guide for more details on the installation of hot 

fixes.  

The content of this hot fix is listed in the hot fix manifest.  

This completes the installation of F90008. You must perform any "Post-Installation Instructions" 

documented below to successfully complete the deployment of this hot fix.  

 

  

http://support.sas.com/kb/37/104.html
http://ftp.sas.com/techsup/download/hotfix/HF2/Maint_Install_Tool.pdf
http://ftp.sas.com/techsup/download/hotfix/HF2/F/F90/F90006/xx/win/F90006wn_manifest.html


POST-INSTALLATION INSTRUCTIONS 

For each product installed, click the link to be redirected to post-installation instructions. 

G55006 for SAS Detail Data Store for Insurance 5.4_M1 

F88008 for SAS Firmwide Risk Management for Insurance Server 2.1_M1 

F89008 for SAS Market Risk Management for Insurance Server 2.1_M1 

F03003 for SAS Risk Dimensions Server Component 5.3_M1 

F12009 for SAS Risk Management for Insurance Server 2.1_M1 

G54006 for SAS Risk Reporting Repository 1.4_M1 

F92008 for SAS Underwriting Risk Management for Life Insurance Server 2.1_M1 

F91008 for SAS Underwriting Risk Management for P&C Insurance Server 2.1_M1 

G61006 for SAS Risk Management for Insurance Mid-Tier 2.1_M1 

 

G55006 for SAS Detail Data Store for Insurance 5.4_M1 

1. If you have existing DDS physical tables, take a backup of the data in a different location. 

2. Following is the summary of the changes in this hot fix:  

Newly added tables:  

ACCOUNTING_TRANS 

ACCOUNTING_TRANS_LINE_ITEM 

ACCOUNT_PERIOD 

ACCOUNT_PERIOD_ASSOC 

ASSET_PORTFOLIO_SEGMENT 

ASSET_PORTFOLIO_SGMNT_X_EXPOSURE 

ASSET_SEGMENT_X_EXPOSURE 

BUSINESS_ENTITY 

CEDED_LOSS 

CLAIMED_INJURED 

CLAIM_UNIT_X_INJURED 

CONTRACT_SECTION_X_RI_CARRIER 

CREDIT_FACILITY_CR_MITIGANT 

CURRENCY_CONVERSION_RATE 

EXPOSURE_PLEDGED 

FRA_INSURMENT_LEG 

GL_SEGMENT_BALANCE 

GL_SEGMENT_PARAMETER 

GL_SEGMENT_PARAM_GROUP 

REINSURANCE_COLLATERAL 

REINSURANCE_CONTRACT 

REINSURANCE_CONTRACT_SECTION 

REINSURANCE_COVERAGE 

REINSURANCE_COVERAGE_REFERENCE 

REINSURANCE_INTERMEDIARY 

REINSURANCE_PROGRAM 

REINSURANCE_RATE 

REINSURANCE_REINSTATEMENT 

RISK_DRIVER 



RISK_DRIVER_X_EXPOSURE 

RI_TRANS_X_CEDED_LOSS 

SUB_LEDGER 

SUB_LEDGER_BALANCE 

XL_LAYER 

XL_LAYER_X_RI_CARRIER 

  

Updated tables:  

CEDED_LOSS 

CREDIT_FACILITY 

EMBEDDED_OPTIONS 

FINANCIAL_ACCOUNT 

FINANCIAL_INSTRUMENT 

FINANCIAL_INSTRUMENT_CHNG 

FINANCIAL_POSITION 

FUND_INSTRUMENT 

PHYSICAL_ASSET 

SECURITIZATION_POOL  

Newly added columns:  

Table Name    Column Name 

 

ASSET_SEGMENT_X_EXPOSURE FINANCIAL_POSITION_RK 

 

BONDED_INSTRUMENT  PRINCIPAL_EXCHANGE_FLG 

     CONVERTIBLE_FLG 

 

BUSINESS_ENTITY                                          BUSINESS_ENTITY_DESC 

     BUSINESS_ENTITY_ID 

     EFFECTIVE_FROM_DTTM 

     EFFECTIVE_TO_DTTM 

     INTERNAL_ORG_RK 

     PROCESSED_DTTM 

     VALID_FROM_DTTM 

     VALID_TO_DTTM 

 

CEDED_LOSS                                                    CEDED_LOSS_AMT_CHANGE_DTTM 

 

COMML_PROP_DETAILS  APPLICATION_RK 

 

COMML_VEHICLE_DETAILS  CEDED_LOSS  

 

CLAIM_UNIT   CLAIM_UNIT_CURRENCY_CD 

     RECOVERY_ESTIMATED_AMT 

     RECOVERY_RECEIVED_AMT 

     APPLICATION_RK 

 

COUNTERPARTY   MIN_CAPITAL_REQ_FLG 

 

CONVERSION_SCHEDULE   VALID_FROM_DTTM  

     VALID_TO_DTTM 

 

COVERED_PERILS   PERIL_RK 



 

FINANCIAL_ACCOUNT  PAYMENT_DAY_OF_MONTH_NO 

     PREPMT_PSA_SPEED_RT 

     INT_PAYMENT_DAY_OF_MONTH_NO 

     RESET_DAY_OF_MONTH_NO 

 

FINANCIAL_INSTRUMENT  PAYMENT_DAY_OF_MONTH_NO 

     INT_PAYMENT_DAY_OF_MONTH_NO 

     RESET_DAY_OF_MONTH_NO 

 

FINANCIAL_INSTRUMENT_ASSOC PHYSICAL_ASSET_RK 

 

FINANCIAL_POSITION                                   CUSTODIAN_COUNTERPARTY_RK 

 

GENERAL_UNIT_OF_EXPOSURE UNDERWRITING_MODEL_AMT 

     UNDERWRITING_MODEL_TYPE_CD 

 

GL_ACCOUNT   CONTROL_ACCOUNT_FLG 

 

GL_ACCOUNT_BALANCE  ACCOUNT_PERIOD_RK 

     AS_OF_DATE 

     GL_BALANCE_BASE_CURRENCY_CD 

     GL_BALANCE_REPT_CURRENCY_CD 

     REPORTING_METHOD_CD 

 

GL_JRNL    REVERSAL_DESC 

     EVERSAL_REASON_CD 

     REVERSED_GL_JRNL_ID 

 

GL_JRNL_DETAILS   ACCOUNT_PERIOD_RK 

 

GL_SEGMENT_PARAM_GROUP  GL_SEGMENT_GROUP_DESC 

 

GL_SEGMENT_PARAMETER  PARAMETER_DESC 

 

LEGAL_PROT_INSURED_SUBJECT APPLICATION_RK 

 

LIABILITY_INSURED_SUBJECT  APPLICATION_RK 

 

PERIL    PERIL_RK 

     VALID_FROM_DTTM 

     VALID_TO_DTTM 

 

PERS_PROP_DETAILS   APPLICATION_RK 

 

PERS_VEHICLE_DETAILS  APPLICATION_RK 

 

REINSURANCE_CARRIER  PARTICIPATION_LIMIT_AMT 

     RI_CARRIER_RK 

     RI_CARRIER_TYPE_CD 

     RI_NETWORK_ID 

 

REINSURANCE_COLLATERAL  EFFECTIVE_DTTM 

     EXPIRATION_DTTM 

 

REINSURANCE_CONTRACT_SECTION GROSS_RETENTION_PCT 



 

REINSURANCE_EXPOSURE  CEDING_COMMISSION_AMT 

     RI_AMT_SHARE 

     RI_CONTRACT_SECTION_RK 

     RI_EXP_EFFECTIVE_DT 

     RI_EXP_EXPIRATION_DT 

 

REINSURANCE_TRANS  RI_CONTRACT_RK 

     RI_CONTRACT_SECTION_RK 

     RI_REINSTATEMENT_RK 

     XL_LAYER_RK 

 

REINSURANCE_TRANS_LINE_ITEM LINE_ITEM_TRANS_AMT 

     RI_CONTRACT_RK 

     RI_CONTRACT_SECTION_RK 

 

RF_CURVE_X_RF_GROUP  VALID_FROM_DTTM  

     VALID_TO_DTTM 

 

RI_TRANS_X_RI_EXPOSURE  RI_CONTRACT_RK 

     RI_EXP_TRANS_AMT 

 

RISK_FACTOR   VALID_FROM_DTTM  

     VALID_TO_DTTM  

 

RISK_FACTOR_CURVE  VALID_FROM_DTTM  

     VALID_TO_DTTM  

 

RISK_FACTOR_GROUP  VALID_FROM_DTTM  

     VALID_TO_DTTM  

 

RSK_FCTR_X_ANAL_MDL_TRANS_METH VALID_FROM_DTTM  

     VALID_TO_DTTM  

 

RISK_FACTOR_X_RISK_FCTR_CURVE VALID_FROM_DTTM  

     VALID_TO_DTTM  

 

SECURITIZATION_POOL  RESECURITIZATION_FLG 

SUB_LEDGER   AS_OF_DT 

 

SWAP_INSTRUMENT_LEG  PAYMENT_DAY_OF_MONTH_NO 

     INT_PAYMENT_DAY_OF_MONTH_NO 

     RESET_DAY_OF_MONTH_NO 

 

TECHNICAL_INSURED_SUBJECT APPLICATION_RK 

OTHER_INSURED_SUBJECT  APPLICATION_RK 

 

XL_LAYER    CAP_RANGE_1_AMT_TYPE_CD 

     CAP_RANGE_2_AMT_TYPE_CD 

     DEDUCTIBLE_1_AMT 

     DEDUCTIBLE_2_AMT 

     LIMIT_1_AMT 

     LIMIT_2_AMT 

 



Renamed Columns:  

The column ASSET_PORTFOLIO_X_EXPOSURE__RK from 

ASSET_PORTFOLIO_SGMNT_X_EXPOSURE table had a typo. It has been renamed 

to ASSET_PORTFOLIO_X_EXPOSURE_RK.  

Deprecated tables and columns:  

A few tables and columns have been deprecated from previous versions. They will be 

removed physically in the future. The comment for such objects has been updated to 

"DEPRECATED" and can be used to know if the table or column is deprecated.  

Table Name     Column Name 

ASSET_SEGMENT_X_EXPOSURE   FINANCIAL_INSTRUMENT_RK 

 

BOND_VOLATILITY_QUOTE   TERM_CD 

 

COMMODITY_VOLATILITY_QUOTE  TERM_CD 

 

CREDIT_SPREAD_QUOTE   TERM_CD 

 

FX_FORWARD_QUOTE    TERM_CD 

 

FX_VOLATILITY_QUOTE   TERM_CD 

 

INDEX_VOLATILITY_QUOTE   TERM_CD 

 

INTEREST_RATE_QUOTE   TERM_CD 

 

PHYSICAL_ASSET_QUOTE   TERM_CD 

 

INT_RATE_VOLATILITY_QUOTE  TERM_CD 

      UNDERLYING_TERM_CD  

 

REINSURANCE_COLLATERAL   EFFECTIVE_DT 

                                               EXPIRATION_DT 

Columns with changed attributes:  

Table Name                             Column Name 

ACCOUNT_PERIOD_ASSOC                            ORDER_NO 

 
CEDED_LOSS                             CEDED_LAE_CASE_RESERVE_AMT 

                                                          CEDED_PAID_LAE_AMT 

 
CURRENCY_CONVERSION_RATE    CONVERSION_RT 

 

 

EXTERNAL_ORG                           NAICS_CD 

                             SIC_CD 



 

FINANCIAL_INSTRUMENT    FINANCIAL_INSTRUMENT_NM 

 

FUND_INSTRUMENT      LEVEL_OF_LOOKTHROUGH_CD 

 

INDEX_QUOTE                            INDEX_CD 

 

INTERNAL_ORG                           NAICS_CD 

                                       SIC_CD 

 

MARKET_DATA     DATA_DTTM 

 
REINSURANCE_CONTRACT     CEDENTS_CONTRACT_ID 

 

REINSURANCE_CONTRACT_SECTION   MAX_COVER_PER_RISK_EVENT 

 

RISK_FACTOR_X_RISK_FCTR_CURVE        VALID_TO_DTTM      

 

RSK_FCTR_X_ANAL_MDL_TRANS_METH       CURR_NUM_UNITS 

 

UNIT_OF_MEASURE      UOM_TYPE_DESC 

 

3. If you already have existing DDS physical tables, execute the ddls of the tables that have 

undergone changes as mentioned in point 2 above from the 

<SASHOME>/SASFoundation/9.2/insurancedds/sasmisc/insurancedds_5.4M1/ddl/sas 

folder. 

4. If you do not have existing DDS physical tables, execute the ddlgen.sas file present in 

<SASHOME>/SASFoundation/9.2/insurancedds/sasmisc/insurancedds_5.4M1/ddl/sas 

folder.  

5. If you already have existing DDS physical tables, migrate data for those tables which are 

updated in this hot fix.  

6. Copy the files present in 

<SASHOME>/SASFoundation/9.2/insurancedds/sasmisc/insurancedds_5.4M1/metadata/ 

folder to a location that can be accessed by DI studio client.  

7. Open DI studio and logon as unrestricted user.  

8. If you have existing metadata for DDS, backup the same.  

9. If you do not have existing metadata for DDS, import insurancedds_54m1_sas.spk 

followed by insurancedds_54m1_hf1_sas.spk, insurancedds_54m1_hf2_sas.spk, 

insurancedds_54m1_hf3_sas.spk, insurancedds_54m1_hf4_sas.spk, and 

insurancedds_54m1_hf5_sas.spk, and insurancedds_54m1_hf6_sas.spk.  

 

Note that before importing the insurancedds_54m1_hf2_sas.spk, please delete the table 

SCHEDULE_X_TREATY from the destination metadata server using DI Studio from the 

folder /Products/SAS Detail Data Store For Insurance/DDS5.4_M1/01] INSURANCE 

PRODUCT. 

 



10. If you have existing metadata for DDS hot fix1, 2, 3, 4 and 5 on top of 5.4M1, import 

insurancedds_54m1_hf6_sas.spk. 

Notes:  

a. Table ASSET_PORTFOLIO_SGMNT_X_EXPOSURE has been renamed to 

ASSET_SEGMENT_X_EXPOSURE. The data if existing in the original table 

needs to be migrated to the newly created table. Please note that the column 

ASSET_PORTFOLIO_X_EXPOSURE_RK in the original table is represented as 

ASSET_SEGMENT_X_EXPOSURE_RK in the new table.  

b. Once all hot fixes have been installed, execute the below code in DI Studio to 

delete the metadata for the physically removed tables/columns.  The code below 

will synchronize table/column metadata as per physical table structures.  

In DI Studio, start the code editor from “Tools” menu and execute below code 

with appropriate values of parameters: 

         Options  metapass=”<password for metadata user>” 

    metaport=<port number> 

  metaprotocol=bridge 

  metarepository=”foundation” 

  metaserver=”<metadata server>” 

  metauser=”<metadata user id>”; 

 

proc metalib; 

 omr (library=”Detail Data Store” repname=”foundation”); 

 update_rule (delete); 

 report; 

run; 

For detailed instructions on creating physical table and importing metadata, please refer to SAS® 

Detail Data Store for Insurance 5.4 Second Edition.  

F88008 for SAS Firmwide Risk Management for Insurance Server 2.1_M1 
 

NONE  

F89008 for SAS Market Risk Management for Insurance Server 2.1_M1 
 

NONE  

F03003 for SAS Risk Dimensions Server Component 5.3_M1 
 

NONE  



F12009 for SAS Risk Management for Insurance Server 2.1_M1 
 

Import updated .spk files:  

1.      Backup existing metadata.  

2.      Import delivered SPK files using SAS MC Import/Export SAS Package wizard  

a. The following analytical STPs have been deprecated:  

 ASSET_VALUATION_HSLT_SCEN  

 HEALTH_CAT_SOLVENCY  

 HNSLT SOLVENCY  

 HSLT_SOLVENCY  

 HSLT_VALUATION_SCEN_LF  

 HEALTH_SCR  

If any of the above analytical STPs exist in your installation or were imported 

during a previous hotfix install, they will need to be manually removed by 

executing the following steps:  

i. Login to SAS Management Console (SMC) as the Administrator (sasadm) 

user  

ii. Click on the Folders tab  

iii. Navigate to the folder Analysis under System -> Applications -> SAS Risk 

Management for Insurance -> Firmwide Risk Server 2.1  

iv. Select the analytical STPs listed above and delete.  

b. Import updated analysis.spk for Firmwide Risk Server 2.1  

i. Login to SAS Management Console (SMC) as the Administrator (sasadm) 

user  

ii. Click on the Folders tab  

iii. Navigate to the folder Analysis under System -> Applications -> SAS Risk 

Management for Insurance -> Firmwide Risk Server 2.1  

iv. Right-click on the Analysis folder and select Import SAS Package from 

the menu  

v. Browse to 

<SASHOME>/SASFoundation/9.2/rmifirmmva/sasmisc/Config/Deploym

ent/Packages and select the analysis.spk file.  

vi. Select the radio button for New Objects Only and click Next  

     You should see the following STPs in the window if not already imported 

in a prior hotfix install. Click Next and then Next again.  

 NLIFE_LOSS_TRIANGLE 

 HEALTH_SOLVENCY 



 FIRMWIDE_MCR 

vii. Ensure that you have the correct mappings for the SAS Application 

Servers. Click Next.  

viii. On this screen, map source code repositories between original and target 

application servers. Choose the path to the 

<SASHOME>\SASFoundation\9.2\rmifirmmva\sasstp folder. Click Next.  

ix. Review the Summary information and click Next if correct. Otherwise, 

click on the Back buttons to make necessary corrections in earlier steps.  

x. The next screen should show that the import was completed. Click the 

View Log button and scan the log for any errors. If the import was 

successful, you should see messages such as the below in the log:  

Create 1 Stored process objects:  

 1. /System/Applications/SAS Risk Management for Insurance/Firmwide 

Risk Server2.1/Analysis/NLIFE_LOSS_TRIANGLE 

xi. Click Ok and then Finish.  

xii. You should now see the newly created STP(s) in the Analysis Folder.  

c. Import updated analysis.spk for Life Risk Server 2.1 (you can skip this step if 

already performed while installing F90006)  

i. Login to SAS Management Console (SMC) as the Administrator (sasadm) 

user  

ii. Click on the Folders tab  

iii. Navigate to the folder Analysis under System -> Applications -> SAS 

Risk Management for Insurance -> Firmwide Risk Server 2.1  

iv. Right-click on the Analysis folder and select Import SAS Package from 

the menu 

v. Browse to 

<SASHOME>/SASFoundation/9.2/rmilifemva/sasmisc/Config/Deployme

nt/Packages and select the analysis.spk file. 

vi. Select the radio button for New Objects Only and click Next  

     You should see the following STPs in the window if not already imported 

in a prior hotfix install. Click Next and then Next again.  

 SLTH_SOLVENCY 

 

vii. Ensure that you have the correct mappings for the SAS Application 

Servers. Click Next.  

viii. On this screen, map source code repositories between original and target 

application servers. Choose the path to the 

<SASHOME>\SASFoundation\9.2\rmilifemva\sasstp folder. Click Next.  

ix. Review the Summary information and click Next if correct. Otherwise, 

click on the Back buttons to make necessary corrections in earlier steps.  



x. The next screen should show that the import was completed. Click the 

View Log button and scan the log for any errors. If the import was 

successful, you should see messages such as the below in the log:  

Create 1 Stored process objects:  

 1. /System/Applications/SAS Risk Management for Insurance/Firmwide 

Risk Server2.1/Analysis/SLTH_SOLVENCY 

xi. Click Ok and then Finish.  

xii. You should now see the newly created STP(s) in the Analysis Folder.  

d. Import updated analysis.spk for Property Casual Risk Server 2.1 (you can 

skip this step if already performed while installing F90006)  

i. Login to SAS Management Console (SMC) as the Administrator (sasadm) 

user  

ii. Click on the Folders tab  

iii. Navigate to the folder Analysis under System -> Applications -> SAS 

Risk Management for Insurance -> Property Casual Risk Server 2.1  

iv. Right-click on the Analysis folder and select Import SAS Package from 

the menu 

v. Browse to 

<SASHOME>/SASFoundation/9.2/rmipcmva/sasmisc/Config/Deploymen

t/Packages and select the analysis.spk file. 

vi. Select the radio button for New Objects Only and click Next  

     You should see the following STPs in the window if not already imported 

in a prior hotfix install. Click Next and then Next again.  

 NSLTH_SOLVENCY 

 

vii. Ensure that you have the correct mappings for the SAS Application 

Servers. Click Next.  

viii. On this screen, map source code repositories between original and target 

application servers. Choose the path to the 

<SASHOME>\SASFoundation\9.2\rmilifemva\sasstp folder. Click Next.  

ix. Review the Summary information and click Next if correct. Otherwise, 

click on the Back buttons to make necessary corrections in earlier steps.  

x. The next screen should show that the import was completed. Click the 

View Log button and scan the log for any errors. If the import was 

successful, you should see messages such as the below in the log:  

Create 1 Stored process objects:  

 1. /System/Applications/SAS Risk Management for Insurance/Firmwide 

Risk Server2.1/Analysis/NLTH_SOLVENCY 

xi. Click Ok and then Finish.  



xii. You should now see the newly created STP(s) in the Analysis Folder.  

e. Import updated reports.spk for the RMI Common Server component 

i. Login to SAS Management Console (SMC) as the Administrator (sasadm) 

user  

ii. Click on the Folders tab  

iii. Navigate to the folder Reports under System -> Applications -> SAS Risk 

Management for Insurance -> Risk Management for Insurance Server 2.1  

iv. Select all the Reports, right-click and select Delete. Ensure that all Reports 

have been deleted from the Reports folder.  
v. Next, right-click on the Reports folder and select Import SAS Package 

from the menu  

vi. Browse to 

<SASHOME>/SASFoundation/9.2/rmicomnsvr/sasmisc/Config/Deployme

nt/Packages and select the reports.spk file.  

vii. Select the radio button for All Objects and click Next  

viii. You should see a list of Reports in the window. Click Next and then Next 

again.  

ix. Ensure that you have the correct mappings for the SAS Application 

Servers. Click Next.  

x. On this screen, map source code repositories between original and target 

application servers. Choose the path to the 

<SASHOME>\SASFoundation\9.2\rmicomnsvr\sasstp folder. Click Next.  

xi. Review the Summary information and click Next if correct. Otherwise, 

click on the Back buttons to make necessary corrections in earlier steps.  

xii. The next screen should show that the import was completed. Click the 

View Log button and scan the log for any errors. If the import was 

successful, you should see a message such as "The import process 

completed successfully" in the log.  

xiii. Click Ok and then Finish.  

xiv. If required, selectively import metadata from the backup SPK (refer to 

Step 1) for only those QRTs that were customized earlier and are not 

delivered in the hot fix.  

f. Import updated system.spk for the RMI Common Server component (you can 

skip this step if already performed while installing F90006) 

i. Click on the Folders tab  

ii. Navigate to the folder System under System -> Applications -> SAS Risk 

Management for Insurance -> Risk Management for Insurance Server 2.1  

iii. Right-click on the System folder and select Import SAS Package from the 

menu  

iv. Browse to 

<SASHOME>/SASFoundation/9.2/rmicomnsvr/sasmisc/Config/Deploym

ent/Packages and select the system.spk file.  

v. Select the radio button for All Objects and click Next  



vi. You should see a list of STPs in the window. Click Next and then Next 

again.  

vii. Ensure that you have the correct mappings for the SAS Application 

Servers. Click Next.  

viii. On this screen, map source code repositories between original and target 

application servers. Choose the path to the 

<SASHOME>\SASFoundation\9.2\rmicomnsvr\sasstp folder. Click Next.  

ix. Review the Summary information and click Next if correct. Otherwise, 

click on the Back buttons to make necessary corrections in earlier steps.  

x. The next screen should show that the import was completed. Click the 

View Log button and scan the log for any errors. If the import was 

successful, you should see a message such as "The import process 

completed successfully" in the log.  

xi. Click Ok and then Finish.  

xii. You should now see  

1. A new "Job name" parameter in the Parameters tab for the 

REPORT_OPTIONS STP if you had not installed F90004 or 

F90005.  

2. A new parameter for XBRL generation.  

g. Remove utility STPs for the RMI Common Server component 

You must perform the following steps before importing the new utilities.spk for 

the RMI Common Server component. If not already done as a part of F90006 

install, the following STPs in the Utilities folder first need to be removed.  

 ACCOUNTING_MEASURES 

 RE_J1 

 RE_J2 

 RE_J3 

 TP_E4 

 TP_E6 

 TP_E7A 

 TP_E7B 

The reason that these STPs need to be removed is to be able to consolidate them 

under a new Data Management folder (which will be installed from the 

utilities.spk files) and also because the .sas files they execute have been renamed. 

If the STP removal was already performed as a part of F90006 install, skip the 

following Step (ii) and just delete the folder named Data Management. This will 

automatically delete the contents in the folder. Otherwise, perform the following 

Step (ii) to first remove the STPs before proceeding to Step h: 

To remove the STPs execute the following steps: 

i. Login to SAS Management Console (SMC) as the Administrator (sasadm) 

user  



ii. Click on the Folders tab  

iii. Navigate to the folder Utilities under System -> Applications -> SAS Risk 

Management for Insurance -> Risk Management for Insurance Server 2.1  

iv. Select the analytical STPs listed above and delete.  

h. Import updated utilities.spk for the RMI Common Server component  

i. Click on the Folders tab  

ii. Navigate to the folder Utilities under System -> Applications -> SAS Risk 

Management for Insurance -> Risk Management for Insurance Server 2.1  

iii. Right-click on the Utilities folder and select Import SAS Package from the 

menu  

iv. Browse to 

<SASHOME>/SASFoundation/9.2/rmicomnsvr/sasmisc/Config/Deploym

ent/Packages and select the utilities.spk file.  

v. Select the radio button for All Objects and click Next  

vi. You should see a list of STPs in the window. Click Next and then Next 

again.  

vii. Ensure that you have the correct mappings for the SAS Application 

Servers. Click Next.  

viii. On this screen, map source code repositories between original and target 

application servers. Choose the path to the 

<SASHOME>\SASFoundation\9.2\rmicomnsvr\sasstp folder. Click Next.  

ix. Review the Summary information and click Next if correct. Otherwise, 

click on the Back buttons to make necessary corrections in earlier steps.  

x. The next screen should show that the import was completed. Click the 

View Log button and scan the log for any errors. If the import was 

successful, you should see a message such as "The import process 

completed successfully" in the log:  

xi. Click Ok and then Finish.  

xii. You should now see the following STPs in the Utilities folder in a new 

"Data Management" folder containing data management jobs:  

 ACCOUNTING_MEASURES 

 LOSS_TRIANGLE 

 RE_J1 

 RE_J2 

 RE_J3 

 TP_E4 

 TP_E6 

 TP_E7A 

 TP_E7B 



i. Import updated rmi_etl_bridge_m1_hf9.spk for the RMI Solution Data Mart 

(SDM) ETL jobs 

i. Following is the summary of the newly added and modified jobs in this 

hot fix:  

Newly added jobs:  

 RMI_INT_100_I_ACCOUNT_CREDIT_RISK_MITIGANT 

 RMI_INT_100_I_CREDIT_FACILITY_CR_MITIGANT 

 RMI_INT_100_I_EXPOSURE_CR_MITIGANT_RANK 

 RMI_INT_100_I_FINANCIAL_POSITION_CR_MITIGANT 

 RMI_INT_100_I_FRA_INSTRUMENT_LEG 

 RMI_INT_100_I_RISK_FACTOR_X_RISK_FCTR_CURVE 

 RMI_STG_210_EXPOSURE_CRM_LINK 

 RMI_STG_210_GL_BAL_SEGMENT_ATTR_VAR 

 RMI_STG_210_GL_BALANCE_SEGMENT 

 RMI_STG_210_RATE_PARAM_GROUP_X_PARAMETER 

 RMI_STG_210_RI_CONTRACT_COLLATERAL 

 RMI_STG_210_SUB_LEDGER 

 RMI_STG_210_ENTITY_SYSTEM_IDENTITY 

 RMI_STG_210_LINE_OF_BUSINESS_ASSOC 

 RMI_STG_230_CAPITAL_ALLOCATION 

 RMI_STG_230_CAPITAL_COST 

Modified Jobs:  

 RMI_INT_100_I_ASSET_SGMNT_X_EXPOSURE  

 RMI_INT_100_I_BOND_INSTRUMENT 

 RMI_INT_100_I_COUNTERPARTY 

 RMI_INT_100_I_CREDIT_CARD_ACCOUNT 

 RMI_INT_100_I_CREDIT_FACILITY 

 RMI_INT_100_I_EXTERNAL_ORG 

 RMI_INT_100_I_FINANCIAL_INSTRUMENT 

 RMI_INT_100_I_FINANCIAL_POSITION 

 RMI_INT_100_I_FX_FORWARD_QUOTE  

 RMI_INT_100_I_FX_VOLATILITY_QUOTE  

 RMI_INT_100_I_INT_RATE_VOLATILITY_QUOTE  

 RMI_INT_100_I_INTEREST_RATE_QUOTE  

 RMI_INT_100_I_PHYSICAL_ASSET 

 RMI_INT_100_I_RISK_FACTOR 

 RMI_INT_100_I_RISK_FACTOR_X_RISK_FCTR_CURV 

 RMI_INT_100_I_SWAP_INSTRUMENT_LEG 

 RMI_INT_105_I_FINANCIAL_ACCOUNT 

 RMI_INT_110_I_ACCT_POS_INST_FCLTY_APPEND 

 RMI_INT_110_I_QUOTE_VOLATILITY 

 RMI_STG_210_CEDED_LOSS 

 RMI_STG_210_CLAIM_HISTORY 

 RMI_STG_210_FUND_INSTRUMENT 

 RMI_STG_210_GENERAL_INSURANCE_SUBJECT 

 RMI_STG_210_GENERAL_INSURANCE_UOE 

 RMI_STG_210_GL_ACCOUNT_ASSOC 



 RMI_STG_210_INSURANCE_SEGMENT 

 RMI_STG_210_INSURED_ITEM_LOCATION 

 RMI_STG_210_LIFE_INSURANCE_POLICY 

 RMI_STG_210_SECURITIZATION_POOL_MART 

 RMI_STG_210_SUB_LEDGER 

 RMI_STG_210_XL_LAYER 

 RMI_STG_230_ASSET_SGMNT_X_EXPOSURE 

 RMI_STG_230_CASHFLOW_ACCOUNT 

 RMI_STG_230_CASHFLOW_ACCOUNT  

 RMI_STG_230_CASHFLOW_FRA 

 RMI_STG_230_CASHFLOW_INSTRUMENT 

 RMI_STG_230_CONVERSION_SCHEDULE 

 RMI_STG_230_CONVERTIBLE_BOND_INSTRUMENT 

 RMI_STG_230_COUNTERPARTY 

 RMI_STG_230_CREDIT_RISK_MITIGANT 

 RMI_STG_230_EMBEDDED_OPTIONS  

 RMI_STG_230_FINANCIAL_CONTRACT 

 RMI_STG_230_FINANCIAL_CONTRACT_ISSUE 

 RMI_STG_230_FINANCIAL_EXPOSURE 

 RMI_STG_230_GL_ACCOUNT 

 RMI_STG_230_OPTION_INSTRUMENT 

 RMI_STG_230_OPTION_SCHEDULE 

 RMI_STG_230_QUOTE_FX 

 RMI_STG_230_QUOTE_INDEX 

 RMI_STG_230_QUOTE_IR 

 RMI_STG_230_QUOTE_IR  

 RMI_STG_230_QUOTE_VOLATILITY 

 RMI_STG_230_QUOTE_VOLATILITY  

 RMI_STG_230_RF_CURVE_X_RF_GROUP 

 RMI_STG_230_RISK_DRIVER 

 RMI_STG_230_RISK_DRIVER_X_FIN_CONTR 

 RMI_STG_230_RISK_FACTOR 

 RMI_STG_230_RISK_FACTOR_CURVE 

 RMI_STG_230_RISK_FACTOR_GROUP 

 RMI_STG_230_RISK_FACTOR_X_RISK_FCTR_CURVE 

 RMI_STG_230_SWAP_INSTRUMENT 

Excluded Jobs: (due to deprecated SDM tables) 

 RMI_STG_210_REINSURANCE_TREATY 

 RMI_STG_210_COUNTERPARTY_X_RI_TREATY  

 RMI_STG_210_CEDED_EXPOSURE 

 RMI_STG_210_RATE_PARAM_GROUP 

ii. If you already have existing RMI21.M1 ETL jobs, then import the  

rmi_etl_bridge_m1_hf9.spk file from 

<SASHOME>/SASFoundation/9.2/SASRiskManagementForInsuranceMi

dTier/2.1/ETL folder as explained below.  

Note: If RMI21.M1 ETL is not existing then first import 

rmi_etl_bridge.spk from the same location.  



A. Login to SAS DI Studio as the Administrator (sasadm) user  

B. Click on the Folders tab  

C. Navigate to the folder Products  

D. Right-click on the Products folder and select Import SAS Package 

from the menu 

E. Browse to /SASRiskManagementForInsuranceMidTier/2.1/ETL 

and select the rmi_etl_bridge_m1_hf9.spk file.  

F. Select the radio button for All Objects and click Next. 

G. Select the objects to Import and click Next  

H. Click Next on ‘Add metadata connections’ Screen 

I. Select the target libraries that correspond to original libraries. Click  

Next 

J. Select the target tables that correspond to original tables. Click 

Next. 

K. Ensure that you have the correct mappings for the SAS Application 

Servers. Click Next.  

L. Review the Summary information and click Next.  

M. The next screen should show that the import was completed. Click 

the View Log button and scan the log for any errors. If the import 

was successful, you should see a message such as "The import 

process completed successfully" in the log  

N. Click Ok and then Finish.  

O. Open the Job ‘RMI_STG_210_INTERNAL_ORG_ASSOC’ 

present under ProductsSAS Risk Management for 

InsuranceRMI 2.1_M1Staging Data MartJobs 

P. In the RMI_STG_210_INTERNAL_ORG_ASSOC job diagram, 

right click the work table of Extract 1. 

Q. Click Properties. 

R. Click Physical Storage tab. 

S. Change the Location from ‘Job’s default library for temporary 

tables’ to ‘Standard temporary library (SAS Work)’. 

T. Click Ok. 

U. Go to File menu, click ‘Save’ to save the changes. 

V. Close the job ‘RMI_STG_210_INTERNAL_ORG_ASSOC’. 

W. Execute the below code in DI Studio to delete the metadata for 

physically removed tables/ columns.  

The code below will synchronize table/ column metadata as per physical 

structures. 

(Assumption: All DDLs for current hot fix have been executed.) 

In DI Studio start the code editor from “Tools” menu and execute below code 

with appropriate values of parameters. 

         



         Options  metapass=”<password for metadata user>” 

    metaport=<port number> 

  metaprotocol=bridge 

  metarepository=”foundation” 

  metaserver=”<metadata server>” 

  metauser=”<metadata user id>”; 

 

 

proc metalib; 

 omr (library=”RMI Staging” repname=”foundation”); 

 update_rule (delete noadd); 

 report; 

run; 
 

3. If required, selectively import metadata from the backup SPK (refer to Step 1) for only 

those QRTs that were customized earlier and are not delivered in the hot fix.  

Follow the steps below to regenerate the Solution Data Mart (SDM):  

1. Locate the create_solution_data_mart.sas file in your install: in a typical install, the 

macro resides under 

<SASHOME>/SASFoundation/9.2/rmicomnsvr/sasmisc/solution_data_mart  

2. Open the create_solution_data_mart.sas file in a BASE SAS session on the installation 

server (where the SAS code resides)  

3. Scroll to the bottom of the macro file and comment out the following line:  

%create_solution_data_mart( 

soln_data_mart_dir=&sysparm, 

fca_c_lib_nm=FINCAD_Suite_32_2011, 

fea_c_lib_nm=intrlib,  

run_tps_fincad_flag=N,  

run_tps_fea_flag=N );  

4. Compile the macro in the SAS session by clicking the Submit button on the menu  

5. After successful compilation, execute the following macro below:  

%create_solution_data_mart(soln_data_mart_dir=<complete path to indata directory in 

your install>);  

Example of indata path: 

<CONFIGDIR>/AppData/SASRiskManagementForInsurance/2.1/indata  

6. Check the SAS log for successful execution of the preceding macro. 

In addition, complete the following to recreate any shared entity data marts and user 

directories.  

7. Delete all user folders found in 

<SASCONFIG>/Lev1/AppData/SASRiskManagementForInsurance/2.1/data/userdata  



8. Login to Risk Management for Insurance 2.1  

9. Select File > Select Entity, choose an entity from the list, and click OK.  

10. Re-create the shared data mart for that entity.  

Select File > Manage Shared Data Mart from the menu and click Delete, then click 

Create in the same Manage Shared Data Mart window.  

11. Repeat steps 8 and 9 for each Entity  

12. To load sample data in to the private SAS Risk Reporting Repositories, execute the 

following code in SAS to create sample data with the appropriate information for your 

installation:  

For example:  

options metauser="<username>" metapass="<Password>"  

metaserver="<server_name>" metaport=<port_number> metarepository="Foundation"; 

%rmiinit; 

%rmi_batch_create_rrr_sample_data(ENTITY=MAIN,USERNAME=<username>,S

COPE=P);  

G54006 for SAS Risk Reporting Repository 1.4_M1 
 

Data model changes have been made to the SAS Risk Reporting Repository. You must update 

the structures of the private RRR location and Shared location.  

There are different ways in which to apply the new structure. Please select one of the following 

methods that is applicable to your installation(s).  

NB: In this release of the SAS Risk Reporting Repository previously marked deprecated tables 

and/or columns have been removed from the model. The files for these structures may still exist 

on your installation due to the delivery mechanism; however, code has been added to ignore the 

pre-existing files when necessary. 

NB: If the post-installation tasks for F12006 have been applied, the structures of the Private 

locations will be automatically updated with the latest reportmart structure for the F120089 post-

installation tasks and the subsequent methods are not necessary for applying the data model 

changes to private RRR locations. The following methods can be applied to both the private and 

shared locations depending on the state of your installation.  

1. Updating via the provided sample data:  

If a given reportmart location has not been updated by another process, creating the shipped 

reportmart sample data in a given location will install the data model changes.  



The shipped sample data scripts already contain the updates in the RRR data model/formats. If 

you would like to utilize the shipped RMI sample data for the RRR without maintaining existing 

data, create the RRR sample data using the following steps.  

Note: The sample data creation script does not depend on the version of the original RRR that is 

being overwritten. This script will overwrite the existing data and data model. For example, if 

you are have the RRR 14 m1 version of the RRR and are installing the sixth RRR hotfix, by 

creating the shipped sample data you do not need to install the "sample data for the previous 

hotfix". The shipped sample data is a snapshot of the given version.  

Submit the following code with your installation specific information. (Note: This has changed 

from previous releases as you are now required to submit the rmiinit; prior to submitting the 

batch program.)  

options metauser="<username>" metapass="<password>" metaserver="<server_name>" 

metaport=<port_number> metarepository="Foundation"; 

%rmiinit; 

%rmi_batch_create_rrr_sample_data(ENTITY=MAIN,USERNAME=<username>,SCOP

E=P);  

* If you need to install the reportmart sample data to the Global RRR with the sample data script, 

you must submit the following code with the additional information and changes:  

%let rrr_user=<username>; 

%let rrr_password=<Password>;  

options metauser="<username>" metapass="<password>" metaserver="<server_name>" 

metaport=<port_number> metarepository="Foundation"; 

%rmiinit; 

%rmi_batch_create_rrr_sample_data(ENTITY=MAIN,USERNAME=<username>,SCOP

E=S); 

NOTE: It is not recommended that you use this process on the Global RRR unless you are 

absolutely certain of your specific installation needs. The script, as shown above, deletes the 

Global RRR and replaces the location with the new version of the RRR with the shipped sample 

data ONLY. All data in the Global location will be lost using this process.  

2. Updating an existing install with alter/migration scripts:  

If you have existing data in your reportmart and wish to only apply the data model changes, 

execute the specific alter scripts for your given installations:  

A. If the reportmart is the RRR14m1 version: execute %run_rrr14m1_to_rrr14m1hf6. Follow 

the instructions to execute this alter script in the PDF document 



m1rrr14_to_m1rrr14hf6_instructions.pdf that has been delivered with the alter scripts. These 

files will be typically located in the following directory:  

Win:  

<SASHOME>\SASFoundation\9.2\rskrptmrtvrt\sasmisc\alterscripts\hotfix_6\m1_to_hotfix6 

Unix:  

<SASHOME>/SASFoundation/9.2/misc/rskrptmrtvrt/alterscripts/hotfix_6/m1_to_hotfix6  

B. If the reportmart is the RRR14m1hf1 version: execute %run_rrr14m1hf1_to_rrr14m1hf6. 

Follow the instructions to execute this alter script in the PDF document 

m1rrr14hf1_to_m1rrr14hf6_instructions.pdf that has been delivered with the alter scripts. These 

files will be typically located in the following directory:  

Win:  

<SASHOME>\SASFoundation\9.2\rskrptmrtvrt\sasmisc\alterscripts\hotfix_6\hotfix1_to_hotfix6  

Unix:  

<SASHOME>/SASFoundation/9.2/misc/rskrptmrtvrt/alterscripts/hotfix_6/hotfix1_to_hotfix6  

C. If the reportmart is the RRR14m1hf2 version: execute %run_rrr14m1hf2_to_rrr14m1hf6. 

Follow the instructions to execute this alter script in the PDF document 

m1rrr14hf2_to_m1rrr14hf6_instructions.pdf that has been delivered with the alter scripts. These 

files will be typically located in the following directory:  

Win:  

<SASHOME>\SASFoundation\9.2\rskrptmrtvrt\sasmisc\alterscripts\hotfix_6\hotfix2_to_hotfix6  

Unix:  

<SASHOME>/SASFoundation/9.2/misc/rskrptmrtvrt/alterscripts/hotfix_6/hotfix2_to_hotfix6  

D. If the reportmart is the RRR14m1hf3 version: execute %run_rrr14m1hf3_to_rrr14m1hf6. 

Follow the instructions to execute this alter script in the PDF document 

m1rrr14hf3_to_m1rrr14hf6_instructions.pdf that has been delivered with the alter scripts. These 

files will be typically located in the following directory:  

Win:  

<SASHOME>\SASFoundation\9.2\rskrptmrtvrt\sasmisc\alterscripts\hotfix_6\hotfix3_to_hotfix6  



Unix:  

<SASHOME>/SASFoundation/9.2/misc/rskrptmrtvrt/alterscripts/hotfix_6/hotfix3_to_hotfix6  

E. If the reportmart is the RRR14m1hf4 version: execute %run_rrr14m1hf4_to_rrr14m1hf6. 

Follow the instructions to execute this alter script in the PDF document 

m1rrr14hf4_to_m1rrr14hf6_instructions.pdf that has been delivered with the alter scripts. These 

files will be typically located in the following directory:  

Win:  

<SASHOME>\SASFoundation\9.2\rskrptmrtvrt\sasmisc\alterscripts\hotfix_6\hotfix4_to_hotfix6 

Unix:  

<SASHOME>/SASFoundation/9.2/misc/rskrptmrtvrt/alterscripts/hotfix_6/hotfix4_to_hotfix6  

F. If the reportmart is the RRR14m1hf5 version: execute %run_rrr14m1hf5_to_rrr14m1hf6. 

Follow the instructions to execute this alter script in the PDF document 

m1rrr14hf5_to_m1rrr14hf6_instructions.pdf that has been delivered with the alter scripts. These 

files will be typically located in the following directory:  

Win:  

<SASHOME>\SASFoundation\9.2\rskrptmrtvrt\sasmisc\alterscripts\hotfix_6\  

Unix:  

<SASHOME>/SASFoundation/9.2/misc/rskrptmrtvrt/alterscripts/hotfix_6/  

3. Installing a new reportmart using the ddls/createrrr.sas script:  

If you would like to create a new RRR with the new data model, follow the instructions for 

installing a clear RRR in the Installing and Configuring the SAS Risk Reporting Repository 

section in the SAS Risk Reporting Repository 1.4 Reference Guide, Second Edition.  

F92008 for SAS Underwriting Risk Management for Life Insurance Server 2.1_M1 
 

NONE  

F91008 for SAS Underwriting Risk Management for P&C Insurance Server 2.1_M1 
 

NONE  

 



G61006 for SAS Risk Management for Insurance Mid-Tier 2.1_M1 
 

If both F90006 and F90007 have been previously installed, the following steps can be skipped 

in their entirety. 

Re-build and Re-deploy Web Application  

Proceed to Step 3-C: Copy files into the application's deployed ear file if F90006 has already 

been installed, otherwise start with Step 1: Re-build Web Application.  

This hot fix requires that the Web Application be rebuilt and redeployed. Use the following steps 

to perform this post-installation task: 

Step 1: Re-build Web Application  

In order for this step to execute correctly, the Metadata Server must be running.  

1.1 Invoke the SAS Deployment Manager 9.2  

From the SASDeploymentManager directory launch config.exe.  

SAS Deployment Manager is installed in the following default location:  

<SASHOME>/SASDeploymentManager/9.2  

1.2 Select a language in the Choose Language box  

1.3 Select Rebuild Web Applications  

1.4 Select Configuration Directory or Enter the Configuration Directory and Level that needs to 

be updated  

1.5 Specify Connection Information, including the sasadm User ID and Password  

1.6 Select Risk Management for Insurance as the Web Application to Rebuild  

1.7 Verify the information on the Summary screen and select Start  

1.8 Select Finish when the deployment is complete  

This process will update the Risk Management for Insurance ear in 

<SASCONFIGDIR>/Web/Staging. 

A backup of the original ear file will be placed in the directory below:  

 

<SASCONFIGDIR>/Web/Staging/Backup  

 

 



Step 2: Re-deploy Web Applications  

Re-deploy the web applications based on the instructions for the web application server you are 

using.  

 

Step 3: Copy files into the application's deployed ear file  

Copy files into your application server’s deployed EAR for SAS Risk Management for Insurance 

as follows:  

A.     web.xml  

From: 

<SASHOME>/SASRiskManagementForInsuraceMidTier/2.1/Static/wars/sas.solutions.ris

k.rmi/WEB-INF/web.xml  

To:  

sas.solutions.risk.rmi.ear /sas.solutions.risk.rmi.war/WEB-INF/web.xml  

B.     app-config.xml 

From: 

<SASHOME>/SASRiskManagementForInsuraceMidTier/2.1/Static/wars/sas.solutions.ris

k.rmi/WEB-INF/spring-config/app-config.xml  

 

To:  

sas.solutions.risk.rmi.ear /sas.solutions.risk.rmi.war/WEB-INF/spring-config/app-

config.xml  

C.     rmx-sas-code-bundles.xml 

From: 

<SASHOME>/SASRiskManagementForInsuraceMidTier/2.1/Static/wars/sas.solutions.ris

k.rmi/WEB-INF/spring-config/rmx-sas-code-bundles.xml  

 

To: sas.solutions.risk.rmi.ear/sas.solutions.risk.rmi.war/WEB-INF/spring-config/rmx-

sas-code-bundles.xml 

Re-start the application (or the application server) using your application server’s admin console.  

Before accessing the web application, empty the Temporary Internet files location on the client 

machine used to access the web application from. This is a precautionary measure to avoid 

problems due to caching of older files in the internet browser.  

This completes the installation of hot fix F90008 on Windows for x64.  


